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Caution  

US Federal law restricts this device to sale by or on the 
order of a physician. 

 

Copyright 
 
© Copyright 2013, Welch Allyn. All rights are reserved. To support the intended use of the 
product described in this publication, the purchaser of the product is permitted to copy this 
publication, for internal distribution only, from the media provided by Welch Allyn. No other 
use, reproduction, or distribution of this publication, or any part of it, is permitted without 
written permission from Welch Allyn. Welch Allyn assumes no responsibility for any injury to 
anyone, or for any illegal or improper use of the product, that may result from failure to use 
this product in accordance with the instructions, cautions, warnings, or statement of 
intended use published in this manual.  Unauthorized copying of this publication may not 
only infringe copyright but also reduce the ability of Welch Allyn to provide accurate and up-
to-date information to users and operators alike. 
 
Welch Allyn

®
, CardioPerfect

®
 Workstation and SpiroPerfect

®
 are registered trademarks of 

Welch Allyn.  
 
Software in this product is Copyright 2013, Welch Allyn. All rights are reserved. The 
software is protected by United States of America copyright laws and international treaty 
provisions applicable worldwide.  Under such laws, the licensee is entitled to use the copy 
of the software provided on the original distribution medium. The software may not be 
copied, decompiled, reverse-engineered, disassembled or otherwise reduced to human-
perceivable form. This is not a sale of the software or any copy of the software; all right, title 
and ownership of the software remains with Welch Allyn.  
 
The information contained in this manual is subject to change without notice.  
All changes will be in compliance with regulations governing manufacture of medical 
equipment. 

 

 

User responsibility 
This product is designed to perform in conformity with the description thereof contained in 
this manual and accompanying labels and inserts, when assembled, operated, maintained 
and repaired in accordance with the instructions provided. A defective product should not 
be used. Parts that are broken, plainly worn, missing or incomplete, distorted or 
contaminated should be replaced immediately. Should any repair or replacement become 
necessary, we recommend that service be performed at the nearest approved service 
center. The user of the product shall have the sole responsibility for any malfunction, which 
results from improper use, faulty maintenance, improper repair, damage or alteration by 
anyone other than Welch Allyn or their authorized service personnel. 
 
 

Accessories 
The Welch Allyn warranty can only be honored if you use Welch Allyn approved 
accessories and replacement parts. 
 

 

Caution  Use of accessories other than those recommended by Welch Allyn may 
compromise product performance. 
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Warranty, Service, and Spare Parts 
 
Warranty 
All repairs on products under warranty must be performed or approved by Welch Allyn. 
Unauthorized repairs will void the warranty. In addition, whether or not covered under 
warranty, any product repair shall exclusively be performed by Welch Allyn certified service 
personnel. 
 
Assistance and Parts 
If the product fails to function properly or if assistance, service, or spare parts are required, 
contact the nearest Welch Allyn Technical Support Center.  
 
USA 1-800-535-6663 Canada  1-800-561-8797 
Latin America (+1) 305-669-9003 South Africa (+27) 11-777-7555 
European Call Center (+353) 46-90-67790 Australia (+61) 2-9638-3000 
United Kingdom (+44) 207-365-6780 Singapore (+65) 6419-8100 
France (+33) 1-55-69-58-49 Japan (+81) 42-703-6084 
Germany (+49) 695-098-5132 China (+86) 21-6327-9631 
Netherlands (+31) 202-061-360 Sweden (+46) 85-853-65-51 
 
Before contacting Welch Allyn, it is helpful to attempt to duplicate the problem and to check 
all accessories to ensure that they are not the cause of the problem. 
 
When calling, please be prepared to provide: 

 Product name and model number and complete description of the problem 

 The serial number of your product (if applicable) 

 The complete name, address and phone number of your facility 

 For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) 
number   

 For parts order, the required spare or replacement part number(s) 
 
Repairs 
If your product requires warranty, extended warranty, or non-warranty repair service, please 
call first the nearest Welch Allyn Technical Support Center. A representative will assist you 
in troubleshooting the problem and will make every effort to solve it over the phone, 
avoiding potential unnecessary return.  
 
In case the return cannot be avoided, the representative will record all necessary 
information and will provide a Return Material Authorization (RMA) number, as well as the 
appropriate return address. A Return Material Authorization (RMA) number must be 
obtained prior to any return. 
 

 Note Welch Allyn does not accept returned products without an RMA. 

 
Packing Instructions 
If you have to return goods for service, follow these recommended packing instructions: 

 Remove all hoses, cables, sensors, power cords, and ancillary products (as appropriate) 
before packing, unless you suspect they are associated with the problem. 

 Wherever possible use the original shipping carton and packing materials. 

 Include a packing list and the Welch Allyn Return Material Authorization (RMA) number. 
 
It is recommended that all returned goods be insured. Claims for loss or damage to the 
product must be initiated by the sender. 
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Limited Warranty Statement 
Welch Allyn, Inc. warrants that the Welch Allyn CardioPerfect Workstation computer based 
product you have purchased meets the labeled specifications of the Product and will be free 
from defects in materials and workmanship that occur within 1 year after the date of 
purchase. Accessories used with the Product are warranted for 90 days after the date of 
purchase.  
 
The date of purchase is: 1) the date specified in our records, if you purchased the Product 
directly from us, 2) the date specified in the warranty registration card that we ask you to 
send to us, or 3) if you don’t return the warranty registration card, 120 days after the date on 
which the Product was sold to the dealer from whom you bought the Product, as 
documented in our records. 
 
This warranty does not cover damage caused by: 1) handling during shipping, 2) use or 
maintenance contrary to labeled instructions, 3) alteration or repair by anyone not 
authorized by Welch Allyn, and 4) accidents. 
 
You assume all responsibility for the use of the Product with any hardware or software that 
does not meet the system requirements described in the Product documentation. 
 
If a Product or accessory covered by this warranty is determined to be defective because of 
defective materials, components, or workmanship, and the warranty claim is made within 
the warranty period described above, Welch Allyn will, at its discretion, repair or replace the 
defective Product or accessory free of charge. 
 
You must obtain a return authorization from Welch Allyn to return your Product before you 
send it to Welch Allyn’s designated service center for repair.  
 
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. WELCH ALLYN'S 
OBLIGATION UNDER THIS WARRANTY IS LIMITED TO REPAIR OR REPLACEMENT 
OF PRODUCTS CONTAINING A DEFECT. WELCH ALLYN IS NOT RESPONSIBLE FOR 
ANY INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING FROM A PRODUCT 
DEFECT COVERED BY THE WARRANTY. 
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Welcome 

Welcome to Welch Allyn CardioPerfect Workstation.  
 
Welch Allyn CardioPerfect Workstation controls the different diagnostic modules and 
handles all non-module specific issues, such as patient management and security. You can 
also use it to search for patients or tests, print tests and import or export tests. 
 

This manual is intended as an introduction to Welch Allyn CardioPerfect Workstation and its 
most important concepts, patients, tests, search patterns and printing procedures. For 
module-specific information, please refer to the particular module manual. 

 

For information on installation and configuration, please refer to the Welch Allyn 
CardioPerfect Workstation Installation manual, for details on servicing and advanced 
installation pleas refer to the Welch Allyn CardioPerfect Workstation Service and Advanced 
Installation manual. 

 
Note 

For a description of intended use, indications and contraindications please refer to the 
appropriate module manual, as these are module specific. 
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Notations used in the Workstation manuals 
The following notations are used: 
 

Dialog boxes 

 The names of dialog boxes, windows and tabs are displayed in bold. 

 When referring to check boxes in dialogs, the term “selected” means that a check is 
displayed in the check box, and therefore that the option is active. 

 When referring to a certain button, setting or menu option the text in this control is 
displayed in bold. 

 

Keyboard 

 All key names are shown in capital letters. For example, the Control key is shown as 
CTRL. 

 Keyboard combinations are indicated by a plus sign (+) placed between key names. For 
example, press ALT+X means that you must press and hold down the ALT key and at 
the same time press the X key. 

 

Mouse 

 The left mouse button is the primary mouse button (unless you have configured it 
otherwise.) 

 Point means to position the mouse pointer until the tip of the pointer rests on the item 
you want to point to on the screen. 

 Click means to press and then immediately release the mouse button. This action is 
always performed using the left mouse button unless specified otherwise. 

 Double click means point to an item, and then quickly press and release the mouse 
button twice. 

 Drag means to point, press and then hold down the mouse button as you move the 
mouse. 

 

 

Caution  Welch Allyn CardioPerfect Workstation was not optimized to be operated 
using a finger to interact with the touchscreen. User Interface controls are 
sized for mouse and stylus use.  Finger touch should not be used. 

Do not use Windows 8 high contrast theme. 
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1. Getting started 

1.1  Start Welch Allyn CardioPerfect Workstation 

To start Welch Allyn CardioPerfect Workstation: 

 

1. In the Windows toolbar, click on the Start button and point to All Programs.  

2. Point to the Welch Allyn folder and click on Welch Allyn CardioPerfect. 
 

1.2  Log in to Welch Allyn CardioPerfect Workstation 

Note:  You only need to follow these steps if you see a window that asks you to provide 
Logon information. 

 

 
 

1. In the Welch Allyn CardioPerfect Workstation window, enter your user name. This 
is the name that you received from your system administrator. 

2. Enter your password. 

3. Click Login. The Welch Allyn CardioPerfect Workstation workspace is displayed. 
 
Note:   
 

When using NT authentication, no user name and password have to be provided. 
If your system was configured to use sites, please select your site. 

 

 

 

1.3  Close Welch Allyn CardioPerfect Workstation 

To close Welch Allyn CardioPerfect Workstation: 
 

 In the File menu, click Exit. 
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1.4  The Welch Allyn CardioPerfect Workstation workspace 

This section will guide you around the various parts of Welch Allyn CardioPerfect 
Workstation. The structure of the workspace is similar to Microsoft Office applications.  
 
 
 

 
 
 
 

Title bar The title bar displays the name of the program. The title bar contains three 
buttons that you can use to maximize, minimize and close the Welch Allyn 
CardioPerfect Workstation window. 

Menu bar Each menu in the menu bar contains a number of tasks that you can 
perform with the Workstation. Sometimes, menus are gray. This means that 
you cannot access that functionality at that particular point, either because 
it is not available, or because you are not authorized to use it. Each 
diagnostic module has its own menu bar. 

Tool bar The tool bar contains buttons that give you easy access to the most 
common tasks in Welch Allyn CardioPerfect Workstation as well as buttons 
for all modules that are available. The look of the tool bar depends on 
which diagnostic module is active: the ECG tool bar, for example, differs 
from the Spirometry tool bar. 

Search area The search area contains search and display functionality that lets you 
easily find patients and tests. In the search area, you can find a patient, see 
which tests were recorded for that patient and see the kind of tests that 
were recorded. You can also create search patterns, an easy way of finding 
information that you need frequently.  

Workspace The workspace displays tests and test related data, such as interpretations, 
measurements and comments. This is where you will do the actual 
recording, viewing and interpretation of tests. 

Shortcut menu In the workspace, you can use these menus to access the most common 
tasks. You can access these tasks by clicking on the workspace with your 
right mouse button. Shortcut menus are context sensitive. This means that 
they only contain those tasks that can be performed in one specific test or 
part of that test. As a result, shortcut menus look different in different tests. 

Menu bar Title bar 

Workspace 

Toolbar Search 
area 

Status bar 

 

Shortcut menu 

Hammilton, J. 
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Status bar The status bar shows important information about the patient and test that 
are currently selected. For example: In the Spiro module the height and the 
weight of the patient are displayed. Additionally, the status bar displays the 
name of the user that is currently logged on to the Workstation.  
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2. Working with patients  

2.1  Patient administration 

With Welch Allyn CardioPerfect Workstation you can easily keep track of your patient 
administration. You can store various kinds of patient information, such as patient name 
and number, address information and medical data that is important for tests.  
 
You can also keep a patient history. For each patient visit, you can enter details that you 
want to be available for future reference. 
  

2.2  The patient card 

The patient card is the key concept in working with patients. Just like a traditional paper 
patient record, it contains various types of patient information, such as name, insurance 
number, address and medical information.  

 

Each patient needs to have a patient card. If a patient does not have a patient card, you 
cannot record a test for that patient. 

 

A patient card can be linked to more than one test. This means that you do not have to 
create a new patient card for each test. So, if a patient needs to have both an ECG and a 
Spirometry test, you can use the same patient card for both tests. 
 

 

2.3  Create a new patient 

Before you can record a test for a patient, you first need to make a record of the patient's 
information. You do this by creating a new patient card.  
 
To create a new patient: 
 
1. In the File menu, point to New and select Patient. An empty patient card is displayed. 

 
2. In the General tab of the patient card, enter the patient's number, name, insurance 

number, gender, birth date, race, weight and height. The patient number is mandatory. 
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3. In the Address tab, enter the patient's address and contact information. 
 

 

 

4. In the History tab, you can enter information on the patient's history, for instance the 
amount of exercise the patient gets. You can start typing under the previous comment. 
You can also check if the patient smokes or has asthma. Welch Allyn CardioPerfect 
Workstation will assign a date and time to your comment. 
 

 
 

5. Click on the OK button or press ENTER to save the patient information. 
 
Tips for creating a new patient: 
 
 Gender, birth date, race, weight and height are not mandatory. However, we strongly 

recommend that you fill in these values, because they are necessary for test 
interpretation and predication equations. 
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2.4  Find a patient   

When a patient has already visited the hospital or your practice, he or she will probably 
already have a Patient card. To check this, you need to search for that patient in the 
computer system. You search for a patient in the Search area. This is the left-hand side of 
the Welch Allyn CardioPerfect Workstation workspace. 
 

 
 
To find a patient: 

1. In the Search area, click on the Patient tab.  

2. In the Search field, type the patient name, the patient number or part of the patient 
name. 

3. Click on the Go button. The patient list automatically displays the patients that match 
your search.  

4. Click on a patient name to select that patient. The test list automatically displays the 
tests that have been recorded for that patient. 

 

2.5  Edit a patient card 

Sometimes, patient information changes, for example when the patients address has 
changed. When this is the case, you need to change the information in the patient card too. 
This way, the computer system will always have the most up to date information available.  
 
To change information in the patient card: 

1. In the patient list, click on the patient that you want to change.  

2. In the Edit menu, select Patient card… or press [ALT]+[P]. The patient card of the 

selected patient is displayed. 

3. Edit the patient information. 

4. Click on OK to save the changes.  

 

Search box 

Go button 

Patient list 

Test list 
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2.6  Delete a patient 

You cannot delete a patient in Welch Allyn CardioPerfect Workstation. If you want to delete 
a patient, for example because you made a mistake in creating a new patient, contact your 
system administrator.  
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3. Working with tests 

3.1  Test modules 

Once you have created a patient card or selected an existing one, you are ready to run a 
test on the patient. Welch Allyn CardioPerfect Workstation offers these diagnostical tests: 

 

 Resting ECG testing  

 Exercise ECG testing  

 Spirometric testing 

 Ambulatory blood pressure testing (ABP) 

 Mini Holter event ECG recordings (Recollect) 
 
In the Welch Allyn CardioPerfect Workstation software, each test has its own module with 
test specific functionality. Not all modules have to be present in one system; your system 
may, for example, contain the Rest and Exercise module, but no Spirometric or ABP 
module. 
 
Welch Allyn CardioPerfect Workstation contains functionality that is common to all tests, 
such as patient and test administration and printing. The instructions that are given in this 
chapter apply to all tests. For test specific information, please refer to the manuals that 
come with the various diagnostic modules. 
 

3.2  Create a new test 

Before you can record a test, you first need to enter some information about that test, like 
the patient and the kind of test. 
 

To create a new test: 

1. Select the patient for whom you want to record the test. 

2. In the File menu, point to New and select the test that you want to run. You can 
choose between: 
 

Rest ECG 
 

Exercise ECG 
 

Spirometry test 
 

Ambulatory blood pressure test 
 

Mini Holter event ECG test    

3. A New test window is displayed. The look of this window depends on the kind of 

test that you selected. 

4. In the New test window, enter the necessary information. 

5. Click the OK button.  

 
Tips for creating new tests: 

To create a new test, you can also: 

 Click on the appropriate button in the toolbar. 
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 Press a shortcut combination on the keyboard 

To start Press 

An ECG [SHFT]+[CTRL]+[E]  

An exercise ECG [SHFT]+[CTRL]+[X]  

A spirometry test [SHFT]+[CTRL]+[S] 

An ABP test [SHFT]+[CTRL]+[B] 

A Mini Holter event ECG test [SHFT]+[CTRL]+[R] 

 

3.3  Find a test 

Once a test has been recorded, it is stored in the database.  
 

To find a test once it is stored: 

1. In the Search box on the Patient tab, select the patient that you want to find the test 
for. 

2. The tests that were recorded for that patient are automatically displayed in the Test list. 
 

Tip for finding tests: 

 You can use search patterns when you want to make your search more detailed. With a 
search pattern, you can search for unconfirmed tests or tests that were recorded by a 
specific person, on a specific location or on a specific date. See page 22 for more 
information. 

 

3.4  View a test 

Once a test has been recorded and stored in the database you can view this test at any 
time. 
 

To view a test: 

1. Select the patient from the patient list. 

2. Click on the test you want to view in the test list. The tests are displayed by 
recording date and time. The icon in front of the date and time indicates the type of 
test: 

 
   Indicates a Rest-ECG recording 

 
   Indicates an Exercise ECG recording 

 
   Indicates a Spirometry recording 

 
    Indicates an ABP recording 

    Indicates a Mini Holter event ECG recording 

3. The appropriate module is opened automatically and the test is displayed in the 
workspace area.  

 

3.5  Delete a test 

When a test is no longer needed, you can delete it. When you delete a test, you do not 
delete the patient that is linked to that test. The patient card of that patient remains in the 
database. 
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Important: Once you have deleted a test, you cannot get it back. It is completely removed 
from the database. So always make sure that you have selected the correct test, and that 
you really want to delete it. 

 

To delete a test: 

1. Select the test that you want to delete. 

2. In the Edit menu, select Delete, or press [CTRL]+[DEL]. A message is displayed 

that asks you if you really want to delete the selected test. 

3. Click the OK button. The test is deleted. 

 

3.6  Place a test on a disk  
You can put a test on a disk, so that you can take it with you and open it on another Welch 
Allyn CardioPerfect Workstation, for example, to show the test to a colleague that is not 
connected to the same database as you. Placing a test on a disk, or on another location on 
your computer, is called exporting a test. 
 

To place a test on a disk: 

1. Insert a removable disk if desired. 

2. Select the test that you want to place on the disk. 

3. From the File menu, select Export. The Export to file dialog box is displayed. 
 

 

4. Select whether you want to export the current test or all tests in the list that are of 
the same type.  

If you select... Then the following is exported... 

Current test Only the test that you selected 

All tests in list of same type All tests for the patient that you selected that are of 
the same type as the test that you selected. 

Example: if you selected an ECG for Mrs. 
Thompson, then all ECGs for Mrs. Thompson are 
exported. 

 

5. Select the location you want to export the files to. In this case, you want to put the 
test on a disk, so use the Browse button to browse to the disk location (A:\). 
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6. Select the format in which the tests must be exported. 

7. Click the OK button. A message is displayed when the export process has finished. 

 

Tips for exporting tests: 

You do not necessarily have to export a test to a floppy or external disk; you can also 
export it to another location on your computer.  

 

Test names 

Each test has a unique name, so that tests are always retrievable and cannot be duplicated. 
The structure of a test name is: 
 

 Test type (ECG/SPIRO/XECG/ABP/Recollect) 

 Recording date (YYYYMMDD) 

 Recording time (HHMMSS) 

 Name of the patient 
 

Example of a test name 

ECG_20000501_100519_Thompson.mdw is an ECG test recorded on May 1, 2000 at 
10:05:19 for patient Thompson.  
 

3.7  Open a test from another location 

You can open tests from other locations on your computer, for example, from a disk. This is 
called importing a test. 
 

To import a test: 

1. Insert the removable disk if desired. 

2. In the File menu, select Import. The Open dialog box is displayed. 

 

3. In the Open dialog box, select the file type that you want to import.  

4. Browse with the Look in: field to the location where the file, that you want to import, 
resides. 

5. Select the file that you want to import.  

6. Click the Open button to import the selected test. A message is displayed when the 

import process has finished. 
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3.8  Use a test in other MS Windows applications 

You can use a test in other MS Windows applications. For example, you can paste an 
image of the test into MS Word. 
 
To use a test in other MS Windows applications: 

1. Select the test view that you want to copy. 

2. Right click on the test view and select Copy from the shortcut menu. You can now 
paste the test into another MS Windows application. 

3.9  Shortcut menus 

The Workstation uses shortcut menus. These menus are context sensitive, which means 
that the contents of the menu are different for different (parts of the) screens. 

Activating a shortcut menu 
By clicking with the right mouse button on the appropriate (part of) the workspace the 
shortcut menu will appear. From this menu you can select options or functions that apply to 
(part of) the screen you clicked on. If an option is active it is displayed with a check in front 
of the option. Once you make a selection from a pop-up menu, the menu disappears. 

3.10  Function keys 

Welch Allyn CardioPerfect Workstation is, just like all Windows applications, designed for 
working with the mouse. However, there might be situations in which working with the 
keyboard can be quicker. Therefore, a number of functions within Welch Allyn 
CardioPerfect Workstation can also be selected directly using the keyboard. Below you will 
find a list of all general available keyboard shortcuts, for a more module specific function 
key description please refer to the corresponding module manual: 

 

General functions 

Key Function 

F1 Activates the Welch Allyn CardioPerfect Workstation Help function. 
Currently not available. 

F2 Starts a new recording, or opens an empty patient card if no module is 
loaded. 

[ALT]+[C] Closes the active module. 

[ALT]+[X] Exits the program. 

[ALT]+[T] Opens the Tools menu. 

[ALT]+[H] Opens the Help menu. 

[ALT]+[A] Opens the Action menu. 

[ALT]+[V] Opens the View menu. 

[ALT]+[M] Opens the Mail menu. 

[CTRL]+[DEL] Deletes the current selected test. 

[CTRL]+[P] Prints the current selected test. 

[CTRL]+[ALT]+[P] Prints selected formats 

 

Patient card 

Key Function 

[ALT]+[P] Opens the patient card of the selected patient and allows you to edit 
the data of the patient. 

[SHIFT]+[CTRL]+[P] Opens an empty patient card and allows you to create a new patient. 

 

Text editing 

Key Function 
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[CTRL]+[X] Cut selected text 

[CTRL]+[C] Copy selected text 

[CTRL]+[V] Past text 

 

Mail 

Key Function 

F5 Send and Receive 

[SHIFT]+F6 Refresh 

 

Start test 

Key Function 

SHIFT]+[CTRL]+[E] Start new resting ECG 

SHIFT]+[CTRL]+[X] Start new exercise ECG 

SHIFT]+[CTRL]+[A] Start new Ambulatory Blood Pressure test 

SHIFT]+[CTRL]+[S] Start new Spirometry test 

SHIFT]+[CTRL]+[R] Start new Mini Holter event ECG 
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4. Search Patterns 

4.1  What is a search pattern? 

A search pattern is an easy way of finding information that you need frequently. You can 
create a search pattern with the search pattern wizard. 

 

There are several types of search patterns: 

Patient  A search pattern to find a specific patient or a specific group of patients. 

Test  A search pattern to find a specific test or a specific group of tests. 

 

Examples of information you can find with a search pattern: 

 At the end of the day, you want to know which ECG tests are still unconfirmed. 

 For a statistical report, you want to know how many male patients of over 50 have 
had an ECG in the last six months. 

 Out of 2000 people called Jones, you want to find Ms Jones with insurance number 
395281-01. 

 For a financial overview, you want to know how many exercise ECGs were 
recorded at each recording site. 

4.2  Define a patient search pattern 

When you want to define a patient search pattern, all you need to do is to start the Patient 
Search Pattern Wizard. This wizard will guide you through the definition process step by 

step.  

 
To define a patient search pattern: 

1. In the Edit menu, select Search patterns. The Define search patterns window is 
displayed.  
 

 

2. In the Define search patterns window, click on New, and select Patient search. 
The Patient Search Pattern Wizard is started. 

3. In the first step of the wizard, select the patient properties you want to search for 
and click Next. 

4. In the following steps, specify the values for each property and click Next.  
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For the... You should specify...   

Name The first or last name. If you enter only a last name, the 
search will return patients with that last name. 
If you enter both a first and a last name, the search will 
return only patients with that exact name.   

Alternate number The alternate number of the patient you want to find.   

Birth date/ Age A date range or an age.    

Gender The gender of the patient you want to find. 

5. In the final step of the wizard, enter a name for your search pattern. The wizard 
already displays a logical name, but you can change this to your own preference. 

6. Click Finish. Your search pattern is now listed in the Search tab at the left hand 

side of the Workstation window. You can use it by clicking on it. 

 
Tips for entering an exact birth date or exact age: 

 To set an exact birth date, set both the between and the and field to the same 
date. 

 To search for a patient of an exact age, select a year in the between and the and 

fields. 

 

4.3  Define a test search pattern 

Just like creating a patient search pattern, creating a test search pattern is just a matter of 
starting the wizard.  
 
To define a test search pattern: 

1. In the Edit menu, select Search patterns. The Define search patterns window is 

displayed.  

2. In the Define search patterns window, click on New, and select Test search. The 
Test Search Pattern Wizard is started. 

3. In the first step of the wizard, select the type of test you want to apply the search to 
or select all tests and click Next.  

4. In the second step of the wizard, select the properties you want to search for and 
click Next. You do not need to select each property. You can also select only one 
or two. 

 

If you select...  Then the Search pattern will look for tests...   

Recording date   Recorded on a particular date. 

Recorded by   Recorded by a specific person. 

Unconfirmed/Confirmed by   Confirmed by a specific person. 

Referring  
Specialism/Physician   

Recorded for a specific Specialism, or 
physician. 
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Ordering  
Specialism/Physician 

Recorded by order of a specific Specialism, or 
physician.  

(Resting ECG and Exercise ECG only) 

Attending  
Specialism/Physician 

Recorded by a specific attending Specialism, or 
physician. 

(Resting ECG and Exercise ECG only) 

Recording Location Recorded on a specific location. 

5. Specify the values for each property and click Next. 
 

For the property... 
   

You should specify... 

Recording date 
   

A relative or absolute date range. 

Recorded by The name of the person that recorded the tests 
you want to find.   

Unconfirmed/Confirmed by Whether you want to search for unconfirmed 
tests or confirmed tests.  
 
If you want to search for confirmed tests, you 
can enter the name of the person that confirmed 
the tests.   

Referring  
Specialism/Physician 

The Specialism or name of the referring 

physician who is linked to the test.   

Ordering 
Specialism/Physician 

The Specialism or name of the ordering 

physician who is linked to the test. 

(Resting ECG and Exercise ECG only) 

Attending 
Specialism/Physician 

The Specialism or name of the attending 
physician who is linked to the test. 

(Resting ECG and Exercise ECG only) 

Recording Location The name of the location where the tests were 
recorded. 

6. In the final step of the wizard, enter a name for your search pattern and click on the 
OK button. The wizard already displays a logical name, but you can change this to 

you own preference. 

7. Click Finish. Your search pattern is now listed in the Search tab at the left hand 

side of the Workstation window. You can use it by clicking on it. 

 

 

Tips for setting the date range in the Test search pattern wizard: 

 A relative date range does not have a fixed start date. For example: today, this 
week, this month, and this year. 

 An absolute date range does have a fixed start and end date. For example: January 
1st through February 18th. You need to use the calendar to enter these dates. 
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5. Printing tests 

With Welch Allyn CardioPerfect Workstation, you can print on plain paper with a regular 
inkjet or laser printer. You can choose from a number of formats in which you want to print 
the information. Each print format has a header that contains additional information.  
You can chose to print one view or multiple views with one mouse click. The multiple views 
printing option is a handy feature if you frequently print the same set of views. To use the 
Print selected formats function, you have to configure this option in the settings. Usually 
this has been done when the program was installed, by the system administrator. 
 

5.1  Print a test 

To print: 

1. Select the patient. 
2. Select the test you want to print from the list of tests.  
 

To print one view: 

1. Select the view you want to print and if desired adjust the view. 
2. Click on the Print button in the toolbar or select Print from the File menu. 
3. In the Print dialog box, the current view is automatically selected. Click on the OK 

button.  
 

To print selected formats: 

1. Select Print selected formats from the File menu. Welch Allyn CardioPerfect prints the 
formats that are selected in the Print tab of the appropriate module settings. 

 
Print header 

Each printed test contains a header with additional information about the test. The header 
contains: 

Patient data name, patient number, gender, birth date, age, height and weight. 

General data recording date and time, name of the person that recorded the test, name 
of the referring physician, name of the ordering physician (Resting ECG 
and Exercise ECG only), the name of the attending physician (Resting ECG 
and Exercise ECG only) the recording location and comments. 

 

5.2  View before printing 

The Print preview function shows how the test will look on paper. From the Print preview 
window, you can view the test at full size or at page width, browse through the pages of the 
test, change the printer setup and print the ECG.  

To view the test before printing: 

1. In the toolbar, click the Print preview button. The Print dialog box is displayed. 
2. Click on the view that you want to see. 
3. Click the OK button. The Print preview is displayed. 

To view... Click... 

The entire page The Page button 
The test at page width The Width button 
The test at actual size The 100% button 
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4. Click the Print button to print the test or click the Close button to return to the main 
window. 
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6.  Change your password 

6.1  When do you need to enter a password? 

You only need to enter a password if you see a login window when you start Welch Allyn 
CardioPerfect Workstation. The login window looks like this: 
 

 
 

6.2  When do you need to change your password? 

How often you change your password is usually left up to you. However, there is one 
situation in which it is recommended that you change it. That is when the system 
administrator has just created your Welch Allyn CardioPerfect Workstation user account. 
Usually, at this time your password is identical to your user name, and therefore easy to 
guess. At this point, it is advisable to change your password. 
 

6.3  Change your password 

To change your password: 

1. In the File menu, click on Change password….  

2. Enter your old password. 

3. Enter your new password. 

4. Re-enter your new password for verification. 

5. Click OK. Your new password is immediately activated. 
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7. Customizing  

7.1  Customize Welch Allyn CardioPerfect Workstation  

Your system administrator configures most settings in Welch Allyn CardioPerfect 
Workstation. However, there are some things that you can change yourself.  
 
The settings that can be freely adjusted are located in the Settings-General window under 
the General tab.  
 

To open the General Settings menu: 

1. In the File menu, click Settings. The Settings dialog box is displayed. 

2. Click General. 

 

Settings General window - General tab 

Use the General tab to customize Welch Allyn CardioPerfect Workstation Framework. In 
this tab, you can set the recording location, the default module that Welch Allyn 
CardioPerfect Workstation should start with and the language of the software. You can also 
adjust the way that patient names are displayed and automatically generate patient 
numbers.  

 

Location Name of the recording location. When you select a location 
name from the list, that name is printed on every test that is 
recorded. You can also leave the recording location empty. 

  

Default module The module that Welch Allyn CardioPerfect Workstation starts 
when you log in to the system. When you select a module from 
the list, Welch Allyn CardioPerfect Workstation automatically 
starts that module when you log in. When you leave the default 
module empty, Welch Allyn CardioPerfect Workstation starts 
with Welch Allyn CardioPerfect Workstation Framework. 

  

Language The language that is used by Welch Allyn CardioPerfect 
Workstation. Welch Allyn CardioPerfect Workstation comes 
with many different languages. You can change the language 
while you work, without restarting the software. 

  

Name display The order in which the patient's first and last name are 
displayed. 

  

Title The order in which the patient's title and name are displayed. If 
you select Do not show, no titles are displayed. 

  
Automatically generate 
patient numbers  

If selected a new patient number is automatically generated 
when a new patient card has been created. 

 
Settings General window - Print tab 

Title on printouts Here you can enter the title which should appear on the printouts.  

 
Settings General window - Mail tab 

Server  Specifies the Server settings. For information see 
your system administrator 
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Mail server Specifies the name of the computer that runs the 
CPWS mail server program. In a standalone 
situation this will be the name of your computer.  

TCP/IP Port mail server  Specifies the TCP/IP port of the Mail server 
program. 

TCP/IP Port notifications Specifies the TCP/IP port used for notification from 
the Mail server program. 

Change settings for all users If checked the changed settings will be applied to 
all users using this computer. 

Auto Signature You can use a signature to automatically add text 
to the messages you send. For example, you can 
create a signature that includes your name, job 
title, and phone number.  

Use Auto Signature If selected the Signature will be added to your 
message. 

Signature In the Signature text box, type the text you want to 
include in the signature. You can also paste text to 
the Signature text box from another document. 

Play sound when new mail arrives If selected a sound is played when new messages 
arrive. 

Settings General window - Mail tab – Advanced settings 

These options are used when you have installed the workstation on a Citrix server or other 
multi user environment on a single server, for example by using the remote desktop. These 
options are only useful when the workstation has been configured as a direct connection 
host.  
 
Disable TCP/IP communication With this option, you can disable the 

communication between the workstation and the 
telemedicine host application. When this option is 
turned on, the mail folders will not be refreshed 
when new mail arrives and the send and receive 
button will be disabled. You can refresh the mail 
folders by using the refresh button in the 
workstation, or enable the periodic refresh option. 

 
Periodically refresh the mail folders With this option, you enabled/disable a periodic 

refresh of the mail folders. When the TCP/IP 
communication has been disabled, the mail 
folders will not refresh automatically. With this 
option, you can configure the workstation to 
refresh the mail folders at a specified interval. 

 
Refresh every Here you can specify the interval at which the 

workstation will refresh the mail folders. The 
interval has to be specified in seconds. You can 
change the value by clicking on the upward arrow 
for an increase of the value and clicking on the 
downward arrow for a decrease of the value. 

 
 

7.2  Customizing File Link 

The CardioPerfect File Link program is a CardioPerfect Workstation plug-in. Click File Link 
> Help for further information. 
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The File Link Preferences window provides the ability to configure Preferences. Click the 
Preferences menu item on the File Link tab to set preferences. Select the File Type and 
Image Type. The path and file naming scheme can be set as desired.  
 
Note that your medical records system may need these to be configured in a specific way. 
Please consult your EMR vendor before making changes. 
 
The checkboxes at the bottom right of the Preferences screen control when output files are 
automatically generated, and the type of output. 
 

 
 
File Types include: 
 
Image (TIF or PDF) Image files have either an extension of TIF or PDF. They can be 

viewed with any image viewer that is compatible with the image file 
type.  

XML Files with an extension of XML contain patient information and test 
results which can be imported into an EMR. 

TFL Files with an extension of TFL can be double-clicked to launch the 
appropriate test in CardioPerfect Workstation.  
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Once you have selected a file type, click the Save current test to selected file formats 
button on the File Link tab to create the default file type of the active test. 
 

 
 

7.3  Customizing .txt files 

You can customize the statements that are used in the Interpretation editor (and Comment 
editor, Spirometry only) according to your own preferences.  

To customize the statements: 

1. As a default, this file is located in <install. dir> \modules\resources\<language 
code>*.txt. Use Notepad to open the file. 

 

Note: If your system was configured to use sites, then the system administrator may have 
selected a different location for these files. 
 

Module: File name: 

  Rest ECG ecg.txt 

 Exercise ECG xecg.txt 

  Spirometry test spiro.txt 

  Ambulatory blood pressure test abp.txt 

   Mini Holter event ECG test recollect.txt 

2. Edit, add and delete the statements according to your own preferences. 

 

To open a file in Notepad: 

1. Open the Windows Explorer. 

2. Browse to the location of the file. 

3. Right click on the file. 

4. In the shortcut menu, click Open with. The Open with dialog box is displayed. 

5. From the program list, select Notepad. 

6. Click OK. The file is opened in Notepad. 
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The *.txt files consist of statements that are grouped in categories. The statements are 
listed under the category name they belong to. Statements indent one position. 

 

To create a new category: 

1. Type the name of the new category on the first position of a new line. 

2. Enter the statements you want to add to this category on new lines, make sure that 
each statement indents one character. 
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8. Telemedicine option 

8.1  Introduction 

Telemedicine is an optional extension to the Welch Allyn CardioPerfect Workstation. 
Without the correct release code, the Telemedicine functionality will not be activated. 
 
With Telemedicine, it is possible to send and receive tests and interpretations to and from 
predefined contacts. This typically allows expertise sharing and second opinion consults, 
but might also be used for administrative purposes in situations where replication cannot be 
used.  
 
Telemedicine offers a choice of two types of communication. Mail messages can be sent 
and received through email facilities, or through direct communication using TCP/IP 
sockets. In both cases, the Internet or any other TCP/IP network must be available as 
transportation infrastructure. It is possible to use a mix of both email and direct socket 
connection. 
 
Telemedicine, like Welch Allyn CardioPerfect Workstation, is built using a client / server 
architecture. This means Telemedicine scales from use on a single standalone computer 
with a modem, to a configuration of multiple client computers, a MSSQL database server 
and a telemedicine mail server working together in a LAN network. 
 
For installation and configuration, please refer to the CPWS Service and Advanced 
Installation manual. 
 

8.2  Using Telemedicine 

Using Telemedicine with e-mail. 
If you use Telemedicine with e-mail, tests will be sent as an e-mail attachment to a pre-
defined e-mail address.  
The tests that are sent will be placed in the recipients mailbox at his ISP (Internet Service 
Provider) waiting to be picked up by the Welch Allyn CardioPerfect workstation of the 
recipient. 
 
Using Telemedicine with e-mail is as simple as sending an e-mail from any e-mail program. 
 

Take the following steps to send one or more tests: 

 Select the first test you want to send and click on the send button,  
 The workstation will now ask you to select the contact you want to send it to, select the 

correct one and click OK, the test will now be placed in the outbox of the Workstation.  
 Do the same for other tests you want to send. 
 After placing all the tests in the Outbox, click on the send/receive button, this will send 

all the tests in the outbox to the selected contacts and at the same time pick up tests 
that have been send to you. 
The person on the receiving end will receive these tests at the moment send/receive is 
executed on the receiving computer.   

 
After sending and receiving tests, a message will appear to let you know how many tests 
were successfully sent and received, or if, for some reason, it was not successful. 
In that case an error code is generated, see the table on error-codes on page 35. 
 

Take the following steps to receive and process received tests: 
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 Click on the Send/receive button to receive tests that have been sent to you 
 If the patient of the received test already has a patient card in the database of the 

recipient, the program will recognize this and place the test directly in the “Inbox”, if the 
patient is not recognized, the test will be placed in “Unresolved items”. 

 Double-click on a test in the “Unresolved items”, the Resolved Patient dialogue (see 
figure) appears, select Create New to create a new patient card for this patient or 
search for a possible match (like you would normally search for a patient in the patient 
list), select the patient you want to add the test to and click assign to.  

 Now that the test has been assigned to an existing patient or a new patient card has 
been created, the test will be placed in the “Inbox” (at the moment a test is placed in the 
“Inbox”, it is also entered in to the database of this workstation) 

 Open the test in the “Inbox”, review or add your interpretation and/or comments as is 
described in the module-specific manual and click Reply, the test will now be placed in 
the “outbox” (a contact does not have to be specified, the program will automatically 
use the e-mail address of the original sender). 

 Alternatively the test can be forwarded to a third (predefined) contact, to do so, click 
Forward and select a contact, the test will be placed in the “Outbox”. 

 Click Send/receive to actually send the tests that are placed in the “Outbox”. 
 

  
 

Using Telemedicine with Direct socket connection. 
Using a direct socket connection means that tests are not sent as an e-mail attachment (an 
e-mail address is not required), instead they are sent directly from the sender (client) to a 
recipient (host), a requirement is that the receiving computer (host) is running and ready to 
receive tests at the moment these tests are transmitted. 
 
 The procedure to send a test with direct connection is similar to sending it by e-mail 

with the exception that the test will not be sent to the ISP of the recipient, but will be 
placed directly in his “Inbox” or “Unresolved items”. 

 After processing the tests, the host must click on Reply to place tests in his “Outbox”, 
the host does not have to click on Send/receive. 

 It is now for the client to pick up his tests directly from the “Outbox” of the host; at the 
moment the client clicks send/receive, the program will check the host for new tests or 
replies that have been placed in the “Outbox” for that client (the program will 
automatically determine which tests are intended for that client) 
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8.3  Troubleshooting 

The following errors or error-messages may come up: 
 
No Mailserver is active:  
Start the Mail server, see the Telemedicine Chapter in the Installation and Configuration 
manual. 
 
Unable to start Welch Allyn CardioPerfect Mail Server: 
There can be only one instance of Mail server running at a time. If the Mail server is already 
running, trying to run the executable CcMailServer will report the above mentioned error. 
Check Windows Task Manager to verify that no instance of Mail server is running.  
If no other instance of Mail server is running yet the server will not start, it is possible that 
the default TCP/IP ports used by Mail server are already used by another application or 
process. Try changing the TCP/IP ports in both Welch Allyn CardioPerfect Workstation and 
CC Mailserver Configuration tool. After changing port settings, restart both Welch Allyn 
CardioPerfect Workstation and the Mail server. When choosing different TCP/IP ports, view 
the file “Services” found in the Windows\System32\drivers\etc folder (Windows XP) or in the 
Winnt\System32\drivers\etc folder (Windows 2000). 
 
Workstation does not close properly:  
Workstation is probably waiting for a time-out trying to contact the Mail server to deregister. 
Check to make sure the Mail server is running. 
 
Incorrect database version: 
Run setup on the computer running the MSDE or MSSQL database server. This will 
upgrade the database to the required version. 
 
Winsock Errors or time-outs on a LAN:  
Make sure Microsoft WinSock Proxy Client is installed and enabled if the LAN is using a 
proxy server. 
 
For other error messages, please refer to the next table 
 

Error 
codes: 

Description 

100 Unknown error 
Action: Try again, if problem persists, contact Support. 

101 A time-out has occurred trying to connect to the SMTP server. 
Action: Try again later, the SMTP server might be down.  
If the problem persists, check the spelling of the SMTP server name using 
CC Mailserver Configuration Tool. Also, verify that the network is functioning 
correctly. 

102 A time-out has occurred trying to send email.  
Action: Try again later.  
If the problem persists, contact the Internet Service Provider (ISP). 
If you are trying to send an exercise ECG, the email attachment might be too 
large. Ask the ISP about any size restrictions. 

103 Unspecified SMTP error. 
Action: Check the error description in the mail event log, it will give the error 
text sent by the SMTP server. 

104 A time-out has occurred trying to connect to the POP server. 
Action: Try again later; the POP server might be down.  
If the problem persists, check the spelling of the POP server name using CC 
Mailserver Configuration Tool. Also, verify that the network is functioning 
correctly. 
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Error 
codes: 

Description 

105 A time-out has occurred trying to receive email.  
Action: Try again later.  
If the problem persists, contact the ISP. 

106 Unspecified POP error. 
Action: Check the error description in the mail event log, it will give the error 
text sent by the POP server. 

107 A mail message has been received that is sent by an unknown contact. A 
rejection message has been sent back to the sender. 
Action: if desired. Add contact using Administrator tool 

108 The mail message that has been received is invalid. It is corrupted or cannot 
be read. A rejection message has been sent back to the sender.  
Action: Try again, if problem persists contact Support.  

109 An interpretation has been received, but the corresponding test is missing. A 
rejection message has been sent back to the sender. 
Action: if the test has been accidentally deleted. Ask the sender to send the 
test first. 

110 A mail message has been received that is sent by a known contact, but the 
password is incorrect. A rejection message has been sent back to the 
sender. 
Action: change contact password or let the sender change the password 
entry 

111 A time-out has occurred trying to connect to a host.  
Action: Try again later; the host may be down. 
If the problem persists, check the contact address of the host using 
Administrator Tool. Also, verify that the network is functioning correctly. 

112 Contact/Host failed to receive mail message or time-out waiting for reply from 
host.  
Action: Check if local user account has writing privileges in the temporary 
directory specified in the CC MailServer Configuration Tool. Check if there is 
enough disk space to temporarily store mail messages, check if the database 
server has enough disk space to grow. 

113 Contact/Host failed to receive mail message or time-out waiting for reply from 
host.  
Action: See error 112. 

114 Direct socket received unknown command or error.  
Future use: possibly host and client are using different software versions.  
Also: connection disconnected by host, the host is going down during a 
connection  
Action: handle like error 111. 
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